
Руководство пользователя и 
технические характеристики  
NI 5782R  
NI 5782 представляет собой аналоговый адаптер приемопередатчика промежуточной 

частоты (IF) с двумя входами и двумя выходами, разработанный для работы с модулем NI 

FlexRIO FPGA. NI 5782 имеет два 14-разрядных канала аналогового ввода (AI) с частотами 

дискретизации до 250 МОтсчетов/c. NI 5782 имеет также два 16-разрядных канала 

аналогового вывода (AO) с частотами дискретизации до 500 МОтсчетов/c при 

использовании обоих каналов или до 1 ГОтсчета/c при использовании только одного канала. 

В данном документе содержатся информация о сигналах и характеристиках модуля  

NI 5782R, состоящего из модуля NI FlexRIO FPGA и адаптера модуля NI 5782. В этом 

документе содержатся также разделы руководства, в которых с использованием примера VI 

LabVIEW FPGA демонстрируется сбор данных, а также создание и запуск собственного 

проекта LabVIEW c NI 5782R. 

 

Примечание NI 5782R означает комбинацию из вашего модуля адаптера NI 5782 

и модуля NI FlexRIO FPGA. NI 5782 означает только модуль адаптера NI 5782. 

Внимание Защита NI 5782R может быть повреждена при использовании его 

способами, не описанными в настоящем документе. 

 

Содержание 

Электромагнитная совместимость ................................................................................................. 2 

Как использовать ваш комплект документации NI FlexRIO........................................................ 3 

Лицевая панель и схема расположения контактов разъема ......................................................... 4 

Блок-схема ........................................................................................................................................ 7 

NI 5782 IP компонентного уровня (CLIP) ..................................................................................... 8 

Подключение кабелей ................................................................................................................... 10 

Таймирование ................................................................................................................................ 10 

Использование NI 5782R с LabVIEW FPGA Пример VI ............................................................ 10 

Создание проекта LabVIEW и запуск VI на целевом устройстве FPGA .................................. 13 

Приложение А Технические характеристики ............................................................................. 17 

Приложение B: Установка элементов для уменьшения уровня электромагнитных помех .... 34 

Куда обратиться за поддержкой ................................................................................................... 35 



 
2   |   ni.com   |   NI 5782R. Руководство пользователя и 

технические характеристики 

 

2   |   ni.com   |   NI 5782R. Руководство пользователя и технические характеристики  

Рисунок 1. Устройство NI FlexRIO 
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Примечание Перед конфигурированием NI 5782R необходимо установить 

соответствующее программное и аппаратное обеспечение. Инструкции по 

установке приведены в документе NIFlexRIO FPGA Module Installation Guide and 

Specifications. На рисунке 1 показан пример правильно подключенного устройства 

NI FlexRIO. 

 

Электромагнитная совместимость 
Данный продукт протестирован и соответствует требованиям и ограничениям нормативных 

документов по электромагнитной совместимости (EMC), приведенным в технических 

характеристиках продукта. Эти требования и ограничения предоставляют достаточную 

защиту от вредных помех при эксплуатации продукта в надлежащей электромагнитной 

среде. 

Продукт предназначен для использования в промышленных условиях. Не гарантируется 

отсутствие вредных помех в случае, если продукт подключен к тестируемому объекту, или 

если продукт используется в жилых помещениях. Для минимизации потенциальных помех 

приему теле- и радиосигналов и предотвращения неприемлемого ухудшения характеристик, 

устанавливайте и используйте данный продукт в строгом соответствии с инструкциями, 

приведенными в настоящем документе. 

Кроме того, любые внесенные в продукт изменения или модификации, не одобренные в 

явном виде National Instruments, могут лишить вас права эксплуатировать продукт согласно 

местным нормативным правилам. 

 

Внимание Для обеспечения соответствия указанной электромагнитной 

совместимости вы должны установить панели заглушки (шифр изделия National 

Instruments 778700-01) в соседние слоты шасси. Для получения дополнительной 

информации об установке панелей-заглушек обратитесь к разделу Приложение B: 

Установка элементов для уменьшения уровня электромагнитных помех данного 

документа. 

 

Внимание Для обеспечения соответствия указанной электромагнитной 

совместимости используйте данный продукт только с экранированными кабелями 

и аксессуарами. 
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Внимание Данный продукт чувствителен к электростатическим разрядам (ESD). 

Для обеспечения соответствия указанной электромагнитной совместимости 

следуйте инструкциям по программированию, приведенным в конце разделов 

Использование NI 5782R с LabVIEW FPGA - пример VI и Создание проекта 

LabVIEW и запуск VI на целевом устройстве FPGA данного документа. 

 

Внимание Для обеспечения указанных характеристик электромагнитной 

совместимости длина всех кабелей ввода-вывода не должна превышать 30 м (100 

футов). 

Как использовать ваш комплект документации 
NI FlexRIO 
Обратитесь к рисунку 2 и таблице 1, чтобы узнать, как использовать ваш комплект 

документации FlexRIO. 
 

Рисунок 2. Как использовать ваш комплект документации NI FlexRIO 
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Таблица 1. Местоположение и описание документации NI FlexRIO 
 

Документ Местоположение Описание 

Руководство по 

установке и 

технические 

характеристики 

модуля NI FlexRIO 
FPGA 

Доступно в комплекте 

поставки модуля FPGA, 

из меню Пуск и на 

странице 

ni.com/manuals.. 

Содержит инструкции по установке 

вашей системы NI FlexRIO и 

технические характеристики вашего 
модуля FPGA. 

Руководство 

пользователя и 

технические 

характеристики NI 

5782R (этот документ) 

Доступно из меню Пуск 

и на странице 

ni.com/manuals. 

Содержит информацию о сигналах, 

примеры, детали CLIP и технические 

характеристики вашего модуля 

адаптера. 

Справка модуля 

LabVIEW FPGA 

 

В справке LabVIEW 

Help, и на странице 

ni.com/manuals. 

Содержит информацию о базовой 

функциональности модуля LabVIEW 
FPGA. 

Справка NI FlexRIO Доступна из меню Пуск 

и на странице ni.com/ 

manuals. 

Содержит информацию по 

конфигурированию модуля FPGA, 

модуля адаптера и CLIP. 

Примеры LabVIEW Доступны в поисковике 

примеров NI Example 

Finder. 

Содержит примеры запуска FPGA VI 

и хост-VI на вашем устройстве. 

IPNet ni.com/ipnet Содержит функции LabVIEW FPGA 

и IP-ядра совместного пользования. 

Страница продукта 
NI FlexRIO 

ni.com/flexrio Содержит информацию о продуктах 

и справочные данные устройств NI 
FlexRIO. 

 

Лицевая панель и схема расположения 
контактов разъема 
В таблице 2 показаны разъем лицевой панели и описания сигналов для NI 5782. Обратитесь к 

разделу Приложение А: Технические характеристики для получения дополнительной 

информации о сигналах. 
 

Внимание Во избежание неустранимого повреждения устройства NI 5782 перед 

отключением питания модуля отсоедините все сигналы, подключенные к NI 5782, 

и подключайте сигналы только после того, как питание адаптера модуля будет 

включено модулем NI FlexRIO FPGA. 
 

Внимание Подключения сигналов, которые превышают любое из максимальных 

значений на любом из разъемов NI 5782R, могут повредить устройство и шасси. 

NI не несет ответственность за повреждения, вызванные подобным подключением 

сигналов. За максимальными значениями входных и выходных сигналов 

обратитесь к разделу Приложение A: Технические характеристики. 



 

NI 5782R. Руководство пользователя и технические характеристики   |   © National Instruments   |   5  

Таблица 2. Разъемы лицевой панели NI 5782 
 

Лицевая панель 

устройства 

 

Разъем 

 

Описание сигнала 

 

AUX I/O Обратитесь к таблице 3 за списком и  

 описанием сигналов. 

CLK IN Несимметричный вход внешнего опорного 

сигнала или тактового сигнала, 50 Ом 

TRIG Входной канал запуска 

AI 0 Несимметричный канал аналогового ввода 

(AI) 0, 50 Ом 

AI 1 Несимметричный канал аналогового ввода 

(AI) 1, 50 Ом 

AO 0 Несимметричный канал аналогового 

вывода (AO) 0, 50 Ом 

AO 1 Несимметричный канал аналогового 

вывода (AO) 1, 50 Ом 
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Разъем AUX I/O 
Таблица 3. Назначения контактов разъема AUX I/O NI 5782  

 

Разъем AUX I/O Контакт Сигнал Описание сигнала 

 

1 Порт DIO 0 (бит 0) Двунаправленный несимметричный 

канал цифрового ввода-вывода (DIO)  

2 GND Опорный уровень для сигналов 

3 Порт DIO 0 (бит 1) Двунаправленный несимметричный 

канал цифрового ввода-вывода 

4 Порт DIO 0 (бит 2) Двунаправленный несимметричный 

канал цифрового ввода-вывода 

5 GND Опорный уровень для сигналов 

6 Порт DIO 0 (бит 3) Двунаправленный несимметричный 

канал цифрового ввода-вывода 

7 Порт DIO 1 (бит 0) Двунаправленный несимметричный 

канал цифрового ввода-вывода 

8 GND Опорный уровень для сигналов 

9 Порт DIO 1 (бит 1) Двунаправленный несимметричный 

канал цифрового ввода-вывода 

10 Порт DIO 1 (бит 2) Двунаправленный несимметричный 

канал цифрового ввода-вывода 

11 GND Опорный уровень для сигналов 

12 Порт DIO 1 (бит 3) Двунаправленный несимметричный 

канал цифрового ввода-вывода 

13 PFI 0 Двунаправленный несимметричный 

канал цифрового ввода-вывода 

14 NC Не подключен 

15 PFI 1 Двунаправленный несимметричный 

канал цифрового ввода-вывода 

16 PFI 2 Двунаправленный несимметричный 

канал цифрового ввода-вывода 

17 GND Опорный уровень для сигналов 

18 +5V Питание +5 В (максимум 10 мА) 

19 PFI 3 Двунаправленный несимметричный 

канал цифрового ввода-вывода 
 

Внимание Разъем AUX I/O совместим со стандартным кабелем HDMI сторонних 

производителей, но порт AUX I/O не является интерфейсом HDMI. Не 

подключайте порт AUX I/O NI 5782 к порту HDMI другого устройства. NI не 

несет ответственность за повреждения, вызванные подобным подключением 

сигналов. 
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Блок-схема 
На рисунке 3 показана блок-схема NI 5782 и поток сигналов в/из IP компонентного уровня 

(CLIP) NI 5782 между адаптером модуля и соответствующим NI 5782 Multiple Sample CLIP в 

LabVIEW FPGA. 
 

Рисунок 3. Сигналы разъема NI 5782 и блок-схема сигналы CLIP NI 5782 
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NI 5782 IP компонентного уровня (CLIP) 
Модуль LabVIEW FPGA предоставляет возможность интеграции HDL IP под названием 

CLIP. Устройства NI FlexRIO поддерживают два типа CLIP: определяемый пользователем и 

подключаемый. 

• Определяемый пользователем CLIP позволяет внедрять HDL IP в целевое устройство 

FPGA, обеспечивая коду VHDL возможность непосредственно взаимодействовать с 

FPGA VI. 

• Подключаемый CLIP предоставляет такую же функциональность интеграции с IP, как 

и определяемый пользователем, но позволяет CLIP непосредственно 

взаимодействовать также и с внешними по отношению к FPGA схемами. 

Подключаемый CLIP адаптера модуля позволяет вашему IP непосредственно 

взаимодействовать и с FPGA VI и с разъемом внешнего интерфейса адаптера модуля. 

На рисунке ниже показаны связи между FPGA VI и CLIP. 
 

Рисунок 4. Отношения CLIP и FPGA VI 

 
 

NI 5782 поставляется с подключаемыми CLIP, которые могут использоваться для добавления 

модуля ввода-вывода в проект LabVIEW: 

1. NI 5782 Multiple Sample CLIP - Каналы аналогового ввода формируют два отсчета на 

каждый импульс тактовой частоты, равной половине частоты дискретизации. Каналы 

аналогового вывода генерируют четыре отсчета на каждый импульс с тактовой 

частотой, равной четверти частоты дискретизации. Тактовая частота AI по умолчанию 

равна 250 МГц, а тактовая частота AO по умолчанию - 500 МГц. Тактовая частота по 

умолчанию для этого CLIP составляет 125 МГц. Вы можете установить более низкую 

частоту, используя внешний сигнал Sample Clock. 
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Этот CLIP представляет данные на диаграмме для пониженной частоты. Данные АЦП 

снимаются с частотой, равной половине частоты тактового сигнала АЦП. Данные ЦАП 

должны быть представлены четырьмя отсчетами на такт в каждом канале. 

CLIP предоставляют доступ к двум каналам аналогового ввода, двум каналам 

аналогового вывода, восьми двунаправленным каналам цифрового ввода-вывода, 

четырем двунаправленным каналам PFI и селектору входного тактового сигнала, 

который может быть сконфигурирован одним из следующих способов: 

– Внутренним тактовым сигналом (Internal Sample clock) 

– Внутренним тактовым сигналом, синхронизированным c внешним опорным сигналом 

(Reference clock) с разъема CLK IN 

– Внешним тактовым сигналом (External Sample clock )  

с разъема CLK IN 

– Внутренним тактовым сигналом, синхронизированным c внешним 

опорным сигналом IoModSyncClock 

– Внешним тактовым сигналом (External Sample clock ) IoModSyncClock 

Элементы CLIP содержат также движок для программирования микросхем генератора, 

АЦП и ЦАП, или заранее определенными параметрами для более простой настройки 

прибора, или через адрес последовательного периферийного интерфейса (SPI) для более 

продвинутой установки. NI 5782 Multiple Sample CLIP является CLIP, используемым по 

умолчанию. 
 

2. NI 5782 Single Sample CLIP - Каналы аналогового ввода генерируют один отсчет за 

такт, а каналы аналогового вывода - два отсчета за такт. Тактовая частота по умолчанию 

для Multiple Sample CLIP составляет 250 МГц. Частоты дискретизации AI (250 МГц) и 

AO (500 МГц) такие же, как для Multiple Sample CLIP. Вы можете установить более 

низкую частоту, используя внешний сигнал Sample Clock. 

Этот CLIP представляет данные на диаграмме с такой тактовой частотой, что данные 

АЦП поступают с той же скоростью, что тактовый сигнал АЦП. Однако данные ЦАП 

должны быть представлены двумя отсчетами на такт в каждом канале. 

CLIP предоставляют доступ к двум каналам аналогового ввода, двум каналам 

аналогового вывода, восьми двунаправленным каналам цифрового ввода-вывода, 

четырем двунаправленным каналам PFI и селектору входного тактового сигнала, 

который может быть настроен одним из следующих способов: 

– Внутренним тактовым сигналом (Internal Sample clock) 

– Внутренним тактовым сигналом, синхронизированным c внешним опорным сигналом 

(Reference clock) с разъема CLK IN 

– Внешним тактовым сигналом (External Sample clock )  

с разъема CLK IN 

– Внутренним тактовым сигналом, синхронизированным c внешним 

опорным сигналом IoModSyncClock 

– Внешним тактовым сигналом (External Sample clock ) IoModSyncClock 

Элементы CLIP содержат также движок для программирования микросхем генератора, 

АЦП и ЦАП, или заранее определенными параметрами для более простой настройки 

прибора, или через адрес последовательного периферийного интерфейса (SPI) для более 

продвинутой установки. NI 5782 Multiple Sample CLIP является CLIP, используемым по 

умолчанию. 
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Обратитесь к справке NI FlexRIO Help для получения дополнительной информации об 

элементах NI FlexRIO CLIP, конфигурировании NI 5782 с подключаемым CLIP, и списком 

доступных сигналов подключаемым CLIP. 

Подключение кабелей 
• Используйте любой кабель SMA сопротивлением 50 Ом для подключения сигналов к 

разъемам лицевой панели NI 5782. 

• Используйте кабель SHH19-H19-AUX (шифр изделия NI: 152629-01 или 152629-02) для 

подключения сигналов DIO и PFI к разъему AUX I/O. 

Для получения дополнительной информации о подключении сигналов ввода-вывода к 

вашему устройству обратитесь к Приложению A: Технические характеристики данного 

документа 
 

Таймирование 
Тактовые сигналы NI 5782управляют частотой дискретизации и другими функциями 

таймирования устройства. В таблице 4 приведена информация о возможных источниках 

тактовых сигналов NI 5782. 

Таблица 4. Источники тактовых сигналов NI 5782 
 

Тактовый сигнал Частота Варианты источника 

Внутренний 

тактовый сигнал 

Без ФАПЧ 

500 МГц Внутренний генератор, управляемый 

напряжением (VCO), работающий как 

независимый тактовый генератор. 

Внутренний 

тактовый сигнал с 

ФАПЧ 
(IoModSyncClock) 

500 МГц Внутренний VCO, синхронизированный 

PXI_CLK10 через IoModSyncClock, который 

доступен только на объединительной панели 
устройств NI PXIe-796xR. 

Внутренний 

тактовый сигнал с 
ФАПЧ (CLK IN) 

500 МГц Внутренний VCO, синхронизированный  внешним 

опорным сигналом Reference Clock (10 МГц). 

Подключайте внешний сигнал Reference Clock 

через разъем CLK IN лицевой панели. 

Внешний тактовый 

сигнал External 
Clock (CLK IN) 

от 250 МГц 

до 1 ГГц 

Подключайте внешний тактовый сигнал через 

разъем лицевой панели CLK IN. 

 

Использование NI 5782R с LabVIEW FPGA 
Пример VI 

 

Примечание Перед запуском данного примера необходимо установить 

программное обеспечение. Обратитесь к документу NI FlexRIO FPGA Installation 

Guide and Specifications для получения дополнительной информации об установке 

вашего программного обеспечения. 
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Программное обеспечение NI FlexRIO Adapter Module Support включает примеры проектов, 

которые помогут вам начать создавать приложения LabVIEW FPGA. В данном разделе 

объясняется, как использовать имеющийся пример проекта LabVIEW FPGA для генерации и 

сбора отсчетов с NI 5782R. Для этого примера требуется как минимум один кабель SMA для 

подключения сигналов к вашему устройству NI 5782R. 

 

Примечание Доступные для вашего устройства примеры зависят от версии 

используемых вами программного обеспечения и драйвера. Для получения 

дополнительной информации о совместимости версий программного обеспечения 

с вашим устройством посетите страницу ni.com/info и введите информационный 

код rdsoftwareversion. 

Каждый пример проекта 5782R содержит следующие элементы: 

• LabVIEW FPGA VI, который может быть скомпилирован и запущен на встроенной 

FPGA. 

• VI, который выполняется на компьютере с ОС Windows и взаимодействует с LabVIEW 

FPGA VI. 
 

Примечание В программном обеспечении модуля LabVIEW FPGA, модули 

адаптера NI FlexRIO обозначаются как модули ввода-вывода (IO Modules). 

Выполните следующие шаги для запуска примера, который соберет отсчеты сигнала с входа 

CH 0 NI 5782. 

1. Подключите один конец кабеля SMA к разъему AI0 на лицевой панели NI 5782., а 

второй конец - к вашему тестируемому устройству. 

2. Запустите LabVIEW. 

3. Для запуска поисковика примеров выберите в меню Help»Find Examples. 

4. В окне поисковика примеров NI Example Finder выберите Hardware Input and Output» 

FlexRIO»IO Modules»NI 5782. 

5. Выберите NI 5782 - Getting Started.lvproj. 

6. В окне Project Explorer откройтеNI 5782 - Getting Started (Host).vi в разделе My 

Computer. Функция Open FPGA VI Reference в этом VI использует NI 7952R как 

целевое устройство FPGA по умолчанию. Если вы используете другой модуль NI 

FlexRIO FPGA, выполните следующие шаги, чтобы заменить поддерживаемое FPGA VI 

целевое устройство. 

a. Выберите меню Window»Show Block Diagram, чтобы открыть блок-диаграмму VI. 

b. Щелкните правой кнопкой мыши по функции Open FPGA VI Reference (NI 

PXI-7952R) и выберите Configure Open FPGA VI Reference. 

c. В диалоговом окне Configure Open FPGA VI Reference щелкните по кнопке 

Browse рядом с кнопкой Bitfile.  

d. В диалоговом окне Select Bitfile выберите двоичный файл для вашего устройства. 

Имя двоичного файла компонуется из адаптера модуля, типа примера и модуля 

FPGA. 

e. Щелкните по кнопке Select. 

f. Щелкните по кнопке OK в диалоговом окне Configure Open FPGA VI Reference. 

g. Сохраните VI. 
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7. На лицевой панели выберите из выпадающего меню RIO Resource ресурс NI 5782R, 

соответствующей выбранному на шаге 6 целевому устройству. 

8. Выберите AI 0 в элементе управления AI Channel. 

9. Установите желаемые значения элементов Trigger Level (V) и Record Size. 

10. В элементе управления Trigger Type вы можете выбрать Software или Data Edge. При 

выборе Software VI собирает данные при каждом щелчке по кнопке Software Trigger на 

лицевой панели VI. При выборе Data Edge VI собирает данные по каждому фронту. 

11. Щелкните по кнопке Run, чтобы запустить VI. 

12. Щелкните по кнопке Software Trigger, если выбрали Software в элементе управления 

Trigger Type. VI собирает данные и отображает измеренный сигнал на графике 

Acquired Waveform, показанном на рисунке 5. 

13. Щелкните по кнопке Stop, чтобы остановить VI. 

14. Закройте VI. 
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Рисунок 5. Лицевая панель NI 5782 - Getting Started (Host) VI 
 

 
 

Создание проекта LabVIEW и запуск VI на 
целевом устройстве FPGA 
В этом разделе объясняется, как конфигурировать целевое устройство, создавать FPGA VI и 

хост-VI для обмена данными. Основное внимание уделяется правильному 

конфигурированию проекта и CLIP, также способам доступа к узлам аналогового ввода и 

вывода 5782 AI AO. Для получения более подробной информации о сборе данных вашим 

устройством NI 5782R, обратитесь к примерам конкретных устройств, доступным в 

поисковике примеров NI Example Finder. 
 

Создание проекта 
1. Запустите LabVIEW. Если LabVIEW уже выполняется, выберите в меню File»Create 

Project. 

2. В диалоговом окне Create Project выберите LabVIEW FPGA Project и щелкните по 

кнопке Finish. 

3. В диалоговом окне Create New LabVIEW FPGA Project выберите FlexRIO on My 

Computer и щелкните по кнопке Next. 

4. Если ваше устройство FlexRIO подключено к системе, выберите Discover Existing 

System. Если ваше устройство не подключено к системе, выберите Create New System и 

щелкните по кнопке Next. 
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5. Выберите ваше устройство и щелкните по кнопке Next. 

6. LabVIEW сгенерирует предварительный вид вашего проекта. Убедитесь, что все верно, 

и выберите Finish. Новый проект откроется в окне Project Explorer.  

 

Создание FPGA VI 
1. Щелкните правой кнопкой мыши по пункту FPGA Target (RIOx, PXI-79xxR) и 

выберите New»FPGA Base Clock. 

2. В выпадающем меню Resource выберите 200 MHz Clock и щелкните по кнопке OK. 

3. Щелкните правой кнопкой мыши по IO Module (5782) в окне Project Explorer и 

выберите Properties. 

4. В категории Clock Selections выберите из выпадающего меню 200 MHz Clock для 

Clk200. Оставьте Clk40 сконфигурированным как Top-Level Clock. 

5. Выберите NI 5782 CLIP в списке Name на панели Component Level IP. 

6. В категории Clock Selections выберите из выпадающего меню 200 MHz Clock для 

Clk200. Оставьте Clk40 сконфигурированным как Top-Level Clock. 

7. Щелкните по кнопке ОК. 
 

Примечание Конфигурирование этих тактовых сигналов необходимо для 

правильной работы CLIP. Обратитесь к разделу NI 5782 CLIP справки NI FlexRIO 

Help для получения дополнительной информации о конфигурирование тактовых 

сигналов. 

8. В окне Project Explorer щелкните правой кнопкой мыши по целевому устройству FPGA 

и выберите New»VI для открытия пустого VI. 

9. Выберите в меню Window»Show Block Diagram, чтобы открыть блок-диаграмму VI. 

10. В окне Project Explorer разверните дерево IO Module (NI 5782 : NI 5782). 

11. Перетащите AI 0 Data N-1 на блок-диаграмму. 

12. Щелкните и растяните нижнюю границу узла, чтобы сделать видимыми другие сигналы, 

AI 0 N-1...AI 1 N. 

13. Добавьте структуру Timed Loop вокруг узла. 

14. Подключите индикаторы к каждому выходному терминалу IO Module\AI 0 N-1...AI 1 N. 

15. Щелкните правой кнопкой мыши по входному узлу цикла Timed Loop для подключения 

к нему FPGA Clock Constant. Задайте эту константу равной IO Module\Data Clock. 
 

Ваша блок-диаграмма должна быть аналогична показанной на рисунке 6. 
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Рисунок 6. Блок-диаграмма 5782SampleAcq (FPGA).vi  
 

 
 

Совет Щелкните по кнопке Clean Up Diagram на панели инструментов для 

упорядочения элементов блок-диаграммы. 

16. Сохраните VI как 5782SampleAcq (FPGA).vi. 

17. Щелкните по кнопке Run. LabVIEW создаст компоновку требований по умолчанию и 

начнет компилировать VI. Откроется окно Generating Intermediate Files, в котором 

отображается процесс генерации кода. Затем откроется окно Compilation Status, где 

отображается прогресс компиляции. Компиляция занимает несколько минут. 

18. Щелкните по кнопке Close в окне Compilation Status. 

19. Сохраните и закройте VI. 

20. Сохраните проект. 

 

Создание хост-VI 
1. В окне Project Explorer щелкните правой кнопкой мыши по пункту My Computer и 

выберите New»VI для открытия пустого VI. 

2. Выберите в меню Window»Show Block Diagram, чтобы открыть блок-диаграмму VI. 

3. Добавьте на блок-диаграмму функцию Open FPGA VI Reference из палитры FPGA 

Interface. 

4. Перетащите 5782SampleAcq(FPGA).vi на функцию Open FPGA VI Reference. Имя 

целевого устройства появится под функцией Open FPGA VI Reference на блок-

диаграмме. 

5. На блок-диаграмме добавьте цикл While справа от функции Open FPGA VI Reference. 

6. Щелкните правой кнопкой мыши по терминалу условия в цикле While и выберите 

Create Control для создания кнопки STOP на лицевой панели VI. 

7. Добавьте функцию Read/Write Control (из палитры FPGA Interface) в цикл While. 

8. Подключите выходной терминал FPGA VI Reference Out функции Open FPGA VI 

Reference к входному терминалу FPGA VI Reference In функции Read/Write Control. 

9. Подключите выходной терминал error out функции Open FPGA VI Reference к 

входному терминалу error in функции Read/Write Control. 

10. Сконфигурируйте функцию Read/Write Control, щелкнув по терминалу Unselected и 

выбрав IO Module/AI 0 N-1. 

11. Щелкните и потяните за нижнюю границу узла, чтобы сделать видимыми другие 

сигналы, AI 0 N-1...AI 1 N, функции Read/Write Control. 
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12. Подключите индикаторы к каждому выходному терминалу IO Module\AI 0 N-1...AI 1 N. 

13. Добавьте функцию Close FPGA VI Reference из палитры FPGA Interface справа от 

цикла While. 

14. Подключите терминал FPGA VI Reference Out функции Read/Write Control к 

терминалу FPGA VI Reference In функции Close FPGA VI Reference. 

15. Подключите терминал error out функции Read/Write Control к терминалу error in 

функции Close FPGA VI Reference. 

Ваша блок-диаграмма должна быть аналогична показанной на рисунке 7. 
 

Рисунок 7. Блок-диаграмма 5782SampleAcq(Host).vi 
 

 
 

16. Сохраните VI как 5782SampleAcq(Host).vi. 
 

Запуск хост-VI 
1. Подключите один конец кабеля SMA к разъему AI0 на лицевой панели NI 5782, а 

второй конец - к вашему тестируемому устройству. 

2. Откройте лицевую панель 5782SampleAcq(Host).vi. 

3. Щелкните по кнопке Run, чтобы запустить VI. 

4. VI собирает данные с тестируемого устройства в AI 0, AI 0 N-1, AI 1 N и AI 1 N-1. 

5. Щелкните по кнопке Stop на лицевой панели и закройте VI. 
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Приложение А: Технические характеристики 
В этом разделе приводятся технические характеристики адаптера модуля NI FlexRIO (NI 

5782). Используйте эти характеристики вместе с приведенными в документе NI FlexRIO 

FPGA Module Installation Guide and Specifications. Для получения дополнительной 

информации о безопасности и электромагнитной совместимости обратитесь к документу 

Read Me First: Safety and Electromagnetic Compatibility, доступному с вашим оборудованием 

или на странице ni.com/manuals. 
 

Внимание Во избежание необратимого повреждения устройства NI 5782 перед 

отключением питания модуля отсоедините все сигналы, подключенные к NI 5782, 

и подключайте сигналы только того, как питание адаптера будет включено 

модулем FlexRIO FPGA. 

Примечание Все характеристики являются типовыми, если не указано иное. На 

всех графиках приведена производительность типичного модуля. 

Характеристики могут быть изменены без уведомления. За последними обновлениями 

характеристик обратитесь по адресу ni.com/manuals. 

 

Аналоговый ввод (AI 0 и AI 1) 

Общие характеристики 
 

Количество каналов Два несимметричных с одновременной 

выборкой 

Разъем SMA 

Входной импеданс 50 Ом на разъеме 

Частота дискретизации  

Внутренний тактовый сигнал 250 МГц 

Внешний тактовый сигнал от 175 МГц до 250 МГц 

Шифр изготовителя АЦП ADS62P491
 разрешение 14 разрядов,  

сдвоенный АПЦ 
 

Технические характеристики при связи по переменному току 
 

Входной диапазон (в нормальных 

рабочих условиях) 

+10,2 дБм (2,05 Впик) 

Абсолютно максимальное входное 

напряжение 

50 Ом, ±10 В постоянного тока, +18 дБм (5 Впик) 

переменного тока 

Полоса пропускания (-1 дБ) от 1 МГц до 250 МГц 

Полоса пропускания (-3 дБ) от 0,1 МГц до 500 МГц 
 

В таблице 5 приведены характеристики спектральной производительности при связи с 

источником сигнала по переменному току. Все значения измерены при частоте внутренних 

импульсов отсчетов 500 МГц. 

                                                           
1
 Для получения дополнительной информации об ADS62P49 обратитесь к справочной документации Texas 

Instruments на устройство на сайте www.ti.com. 

http://www.ti.com/
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Таблица 5. Спектральная производительность аналогового ввода по переменному току 
 

Измерение 20,1 МГц 70,1 МГц 124,1 МГц 

Отношение сигнал-шум 

(SNR) 

70,5 дБ 70,0 дБ 68,8 дБ 

Отношение сигнала к шуму и 

искажениям (SINAD) 
70,5 дБ 69,8 дБ 68,6 дБ 

Динамический диапазон без 

паразитных составляющих 

(SFDR) 

90,0 дБ 83,0 дБ 80,0 дБ 

 

Изоляция между каналами  

1 МГц >90 дБ 

100,1 МГц 90 дБ 

501 МГц 70 дБ 

 

Рисунок 8. Полоса пропускания 

 
 

dBFS – дБ относительно полной шкалы 
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Рисунок 9. Согласованный вход 

 
 

 

Рисунок 10. Измерение спектра одного тона (70МГц, -1 dBFS) 
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Рисунок 11. Измерение спектра двух тонов (19.5 и 20.5 МГц, -10 dBFS) 

 

Технические характеристики при связи по постоянному току 
 

Входной диапазон (в нормальных 

рабочих условиях) 

+4,0 дБм (1,0 Впик) 

Абсолютно максимальное входное 

напряжение 

50 Ом, ±4,5 В постоянного тока, +15 дБм  

(3,6 Впик) переменного тока 

Полоса пропускания (-1 дБ) От 0 Гц до 170 МГц 

Полоса пропускания (-3 дБ) От 0 Гц до 330 МГц 

 

В таблице 6 приведены характеристики спектральной производительности при связи с 

источником сигнала по постоянному току. Все значения измерены при частоте внутренних 

импульсов отсчетов 1 ГГц.  
 

Таблица 6. Спектральная производительность аналогового ввода  
при связи по постоянному току 

 

Измерение 20,1 МГц 70,1 МГц 124,1 МГц 

SNR 67,3 дБ 66,2 дБ 65,5 дБ 

SINAD 67,0 дБ 65,4 дБ 64,0 дБ 

SFDR 80,0 дБ 78,0 дБ 66,0 дБ 
 

Изоляция между каналами  

1 МГц 85 дБ 

100,1 МГц 85 дБ 

501 МГц 60 дБ 
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Рисунок 12. Полоса пропускания аналогового ввода 

 

 

 

Рисунок 13. Согласованный вход 
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Рисунок 14. Измерение спектра одного тона (70МГц, -1 dBFS) 

 

Рисунок 15. Измерение спектра двух тонов (19.5 и 20.5 МГц, -10 dBFS) 

 

 

Аналоговый вывод (AO 0 и AO 1) 

Общие характеристики 
Количество каналов Два несимметричных с одновременной 

выборкой 

Разъем SMA 

Выходной импеданс 50 Ом на разъеме 
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Частота дискретизации  

Без ФАПЧ <250 МГц 

С ФАПЧ от 250 МГц до 1 ГГц 

Шифр изготовителя ЦАП DAC5682Z1; разрешение 16 разрядов, сдвоенный 

ЦАП 

 

Технические характеристики при связи по переменному току 
Выходной диапазон (в нормальных 

рабочих условиях) 

-0,5 дБм (0,6 Впик) 

Полоса пропускания (-3 дБ) от 1 МГц до 225 МГц2 

Отношение сигнал-шум 70 дБн 

Таблица 7. SFDR (70 МГц выход, 1 ГОтсчет/c, без PLL) 
 

Без гармоник Вторая гармоника Третья гармоника 

77 дБн 61 дБн 72 дБн 
 

Изоляция между каналами  

1 МГц 100 дБ 

100,1 МГц 90 дБ 

501 МГц 90 дБ 
 

Рисунок 16. Полоса пропускания 

 
  

                                                           
1 Для получения дополнительной информации о DAC5682Z обратитесь к справочной 

документации Texas Instruments на устройство на сайте www.ti.com. 
2
 Включая SINC отклик ЦАП. 

http://www.ti.com/
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Рисунок 17. Измерение спектра одного тона на аналоговом выходе (70 МГц,  
0,25 дБм, 100 Гц разрешение полосы пропускания, 100 кГц полоса пропускания) 

 

 
 
 

 
 

Рисунок 18. Измерение спектра одного тона на аналоговом выходе (70 МГц, 0,25 
дБм, 1 кГц разрешение полосы пропускания, 1 МГц полоса пропускания) 
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Рисунок 19. Измерение спектра одного тона на аналоговом выходе (70 МГц,  
0,25 дБм, 1 кГц разрешение полосы пропускания, 100 МГц полоса пропускания) 

 

 

 

Рисунок 20. Измерение спектра одного тона на аналоговом выходе (70 МГц,  
0,25 дБм, 1 кГц разрешение полосы пропускания, 500 МГц полоса пропускания) 

 

Технические характеристики при связи по постоянному току 
Выходной диапазон (в нормальных 

рабочих условиях) 

+4 дБм (1,0 Впик) 

Полоса пропускания (-3 дБ) От 0 Гц до 180 МГц 1 

Отношение сигнал-шум 66 дБн 

                                                           
1
 Включая SINC отклик ЦАП. 
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Таблица 8. SFDR (70 МГц выход, 1 ГОтсчет/c, без PLL) 
 

Без гармоник Вторая гармоника Третья гармоника 

77 дБн/Гц 47 дБн/Гц 47 дБн/Гц 
 

Изоляция между каналами  

1 МГц 100 дБ 

100,1 МГц 100 дБ 

501 МГц 87 дБ 
 

Рисунок 21. Полоса пропускания аналогового ввода 

 

Рисунок 22. Измерение спектра одного тона на аналоговом выходе (70 МГц,  
0,25 дБм, 100 Гц разрешение полосы пропускания, 100 кГц полоса пропускания) 
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Рисунок 23. Измерение спектра одного тона на аналоговом выходе (70 МГц,  
0,25 дБм, 1 кГц разрешение полосы пропускания, 1 МГц полоса пропускания) 

 

 

 

 

Рисунок 24. Измерение спектра одного тона на аналоговом выходе (70 МГц,  
0,25 дБм, 1 кГц разрешение полосы пропускания, 100 МГц полоса пропускания) 
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Рисунок 25. Измерение спектра одного тона на аналоговом выходе (70 МГц,  
0,25 дБм, 1 кГц разрешение полосы пропускания, 500 МГц полоса пропускания) 

 

 
 

Внутренний генератор импульсов отсчетов 

Общие характеристики 
Тип осциллятора Синтезатор с фиксированной частотой 

Частота по умолчанию 1 ГГц 

Негармонические составляющие в 

опорном сигнале 

<60 дБн 

Фазовый шум  

Смещение 10 кГц -95 дБн/Гц 

Смещение 100 кГц -115 дБн/Гц 

Распределитель тактовых импульсов, 

шифр изделия 

AD95121 

Источники опорного сигнала Внутренний, внешний с разъема CLK IN или 

IoModSyncClock2  

Тип внутреннего опорного генератора TCXO 

Нестабильность внутреннего генератора ±1 ppm 

Частота внутреннего генератора по 

умолчанию 

10 МГц 

Фазовый шум внутреннего генератора  

Смещение 1 кГц -137 дБн/Гц 

                                                           
1 Для получения дополнительной информации о AD9512 обратитесь к справочной документации Analog 

Devices на устройство на сайте www.analog.com. 
2
 IoModSyncClock доступен только в модулях NI PXIe-796xR FPGA 

http://www.analog.com/
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Смещение 10 кГц -150 дБн/Гц 

Смещение 100 кГц -155 дБн/Гц 

 

CLK IN 

Общие характеристики 
Количество каналов 1, несимметричный 

Разъем SMA 

Входной импеданс 50 Ом 

Связь с источником сигнала По переменному току (АС) 

 

Внешний тактовый сигнал 
Диапазон входного напряжения От 0,63 Впик до 2,5 Впик 

Диапазон входной частоты От 250 МГц до 1 ГГц 

Абсолютно максимальное входное 

напряжение 

±10 В по постоянному току,  

3,1 Впик по переменному току 

Входная мощность (50 Ом) От 0 дБм до 12 дБм 

 

Вход внешнего опорного сигнала 
Диапазон входного напряжения От 1.4 Впик до 4.4 Впик 

Диапазон входной частоты 10 МГц 

Абсолютно максимальные значения ±10 В по постоянному току,  

5 Впик по переменному току 

Входная мощность (50 Ом). От 7,0 дБм до 16,8 дБм 

TRIG 

Общие характеристики 
Число каналов 1, несимметричный 

Разъем SMA 

Входной импеданс 10 кОм 

Тип соединения на входе По постоянному току (DC) 

Таблица 9. Входное напряжение 
 

Уровни напряжений Минимум Максимум 

VIL 0,0 В 0,8 В 

VIH 2,0 В 3,6 В 
 

 

Абсолютно максимальное значение ±10 В 
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AUX I/O (Порт 0 DIO <0..3>, порт 1 DIO <0..3> и PFI 
<0..3>) 

Общие характеристики 
Количество каналов 12 двунаправленных (8 DIO и 4 PFI) 

Разъем HDMI  

Стандарт интерфейса 3,3 В LVCMOS 

Логические уровни интерфейса  

Макс. VIL 0,8 В 

Мин. VIL -0,3 В 

Мин. VIH 2,0 В 

Макс. VIН 3,6 В 

Макс. VOL 0,4 В 

Мин. VОL 0 В 

Мин. VОH 2,7 В 

Макс. VОH 3,6 В 

Zout 50 Ом ± 0,8% 

Iout (DC) ±2 мА 

Подтягивающий резистор  150 кОм 

Рекомендуемое рабочее напряжение от -0,3 В до 3,6 В 

Защита от перегрузки по напряжению ±10 В 

Максимальная частота переключения 6,6 МГц 

Максимальный ток от +5 В 10 мА 

Допустимое отклонение напряжения  

от +5 В 
от 4 В до 5,0 В 

 

EEPROM 
Таблица 10. Карта EEPROM 

 

Адрес байта Размер (байт) Имя поля 

0x0 2 ID изготовителя 

0x2 2 ID продукта 

0x4 4 Серийный номер 

0x8 116 Зарезервирован 

0x7C 132 Отведено для пользователей 
 

 

Внимание Запись производите только в место, отведенное для пользователей. 

Запись в любое другое место может привести к прекращению функционирования 

NI 5782. 
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Питание 
 

Потребляемая мощность (Вт)  

При связи по переменному току 4,59 

При связи по постоянному току 5,26 

 

Требования к питанию по постоянному току 
VCCOA, VCCOB от 2,37 В до 2,60 В 

VEEPROM от 2,50 В до 5,50 В 

P33V от 3,09 В до 3,47 В 

P12 от 11,12 В до 12,60 В 

 

Физические характеристики 
Размеры 11,4 × 10,2 × 2 см 

Вес 317,5 г 

 

Условия эксплуатации 
Температура окружающей среды1 от 0 °C до 55 °C, протестировано в 

соответствии со стандартами IEC-60068-2-1 и 

IEC-60068-2-2 

Относительная влажность от 10% до 90%, без конденсата, 

протестировано в соответствии со стандартом 

IEC-60068-2-56. 

Максимальная высота над уровнем моря 2000 м (при температуре окружающей  

среды 25 °C) 

Степень загрязнения 2 

Для эксплуатации только в помещении.  

Условия хранения 
Температура окружающей среды от -20 °C до 70 °C, протестировано в 

соответствии со стандартами IEC-60068-2-1 и 

IEC-60068-2-2 

Относительная влажность от 5% до 95%, без конденсата, 

протестировано в соответствии со стандартом 

IEC-60068-2-56. 
 

Примечание Очищайте устройство мягкой, неметаллической кисточкой. 

Убедитесь, что устройство полностью сухо и свободно от загрязнений перед его 

повторным включением. 

 

                                                           
1
 Для конфигураций шасси PXI/PXI Express с адаптерами модулей NI FlexRIO в трех или более соседних 

слотах National Instruments рекомендует ограничивать температуру окружающей среды ниже 50 C 
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Устойчивость к ударам и вибрации 
Удары в условиях эксплуатации 30 g, полупериод синуса, 11 мс импульс, 

протестировано в соответствии со стандартом 

IEC-60068-2-27. Режим испытания разработан 

в соответствии с MIL-PRF-28800F. 

Случайные вибрации  

В процессе эксплуатации От 5 Гц до 500 Гц, 0,3 g СКЗ 

Не в процессе эксплуатации От 5 до 500 Гц, 2.4 g СКЗ, протестировано в 

соответствии со стандартом IEC-60068-2-64. 

Тестовый профиль не в процессе 

эксплуатации превышает требования MIL- 

PRF-28800F, класс 3). 

 

Безопасность 
Изделие соответствует требованиям следующих стандартов по безопасности 

электрооборудования для измерений, управления и лабораторного применения: 

• IEC 61010-1, EN 61010-1 

• UL 61010-1, CSA 61010-1 

 

Примечание: Информацию о сертификатах вы можете найти на товарной 

этикетке, или в разделе Онлайн-сертификация. 

 

Электромагнитная совместимость 
Изделие удовлетворяет требованиям следующих стандартов по электромагнитной 

совместимости (ЭМС) электрооборудования для измерений, управления и лабораторного 

применения: 

• EN 61326-1 (IEC 61326-1): Требования к ЭМС; Класс А; Минимальные требования к 

помехозащищенности 

• EN 55011 (CISPR 11): Группа 1; Класс А излучений 

• AS/NZS CISPR 11: Группа 1; Класс А излучений 

• FCC 47 CFR Часть 15B: Класс А излучений 

• ICES-001): Класс А излучений 

 

Примечание В Соединенных Штатах (согласно федеральному закону FCC 47 

CFR), оборудование класса А предназначено для использования в коммерческих 

зданиях, зданиях легкой и тяжелой промышленности. В Европе, Канаде, 

Австралии и Новой Зеландии (согласно CISPR 11) оборудование класса А 

предназначено для использования только в зданиях тяжелой промышленности. 

 

Примечание К оборудованию группы 1 (по CISPR 11) относится любое 

промышленное, научное или медицинское оборудование, которое не генерирует 

намеренно радиочастотную энергию для обработки материалов, дефектоскопии 

или анализа. 
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Примечание За получением деклараций и сертификатов о соответствии 

требованиям стандартов по электромагнитной совместимости обратитесь к 

разделу Онлайн-сертификация . 

 

Соответствие требованиям Совета Европы  
Изделие соответствует основным требованиям следующих директив СЕ: 

• 2006/95/EC; Директива по безопасности низковольтного оборудования 

• 2004/108/EС; Директива по ЭМС. 
 

Oнлайн-сертификация 
Для получения сертификатов и Декларации о соответствии (DoC) этого изделия посетите 

страницу ni.com/certification, выполните поиск по серии и номеру модели, и 

щелкните по соответствующей ссылке в столбце Certification. 
 

Охрана окружающей среды 
NI разрабатывает и производит продукцию с учетом требований по защите окружающей 

среды и принимает во внимание, что отказ от использования некоторых опасных веществ 

при изготовлении изделий полезен как для среды обитания, так и для потребителей. 
 

Дополнительная информация по защите окружающей среды находится на странице 

Минимизации нашего воздействия на окружающую среду на странице 

ni.com/environment. Эта страница содержит положения и директивы по охране 

окружающей среды, которые соблюдает компания NI, а также другая информация о защите 

окружающей среды, не включенная в настоящий документ. 
 

Утилизация электрического и электронного 
оборудования (WEEE) 

 Пользователям ЕС: По истечении срока службы любая продукция должна быть 

отправлена в центр по переработке электрического и электротехнического 

оборудования (WEEE). Для получения информации о WEEE центрах по 

переработке, инициативах National Instruments по WEEE, а также о соответствии с 

WEEE Директивой 2002/96/ЕС обратитесь на сайт ni.com/environment/weee. 
 

电子信息产品污染控制管理办法（中国 RoHS） 

 中国客户 National Instruments 符合中国电子信息产品中限制使用某些有害物 
质指令(RoHS). 关于 National Instruments 中国 RoHS 合规性信息，请登录 

ni.com/environment/rohs_china. (Для получения информации о директиве по 

ограничению вредных веществ в Китае, обратитесь на страницу 

ni.com/environment/rohs_china.) 
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Приложение B: Установка элементов для 
уменьшения уровня электромагнитных помех 
Для обеспечения указанных характеристик электромагнитной совместимости в вашей 

системе FlexRIO должны быть установлены панели-заглушки PXI. В ваш комплект поставки 

включено ферритовое кольцо на кабель HDMI, но панели-заглушки PXI (шифр изделия 

National Instruments 778700-01) необходимо приобретать отдельно. Руководство по установке 

приведено в документе FlexRIO FPGA Module Installation Guide and Specifications. 
 

Установка панелей-заглушек для PXI 
Выполните следующие инструкции, чтобы установить панели-заглушки (шифр изделия 

National Instruments 778700-01) в ваше шасси PXI: 

1. Снимите крышки невыпадающих винтов. 

2. Установите панели-заглушки PXI, прикрепив невыпадающие винты к шасси, как 

показано на рисунке ниже. Убедитесь, что уплотнитель для защиты от EMC находится с 

правой стороны панели-заглушки PXI. 

Рисунок 26. Шасси и панели-заглушки PXI EMC   
 

 
 
 

1 Крышки невыпадающих винтов 2 Невыпадающие винты 3 Уплотнитель для защиты от EMC 

 

Примечание Вы должны заполнить все слоты модулями или панелями-

заглушками, чтобы обеспечить правильное охлаждение модуля. Не затягивайте 

винты слишком сильно (максимум 2,5 фунтов · дм.). Для получения 

дополнительной информации об использовании панелей-заглушек PXI EMC в 

вашей системе PXI посетите сайт ni.com/info и введите информационный код 

emcpanels. 



 

 

Куда обратиться за поддержкой 
Веб-сайт NI является полноценным ресурсом вашей технической поддержки. На 

ni.com/support вы можете получить любую информацию, начиная с выявления 

неисправностей и ресурсов для самостоятельного поиска ответов по разработке приложений 

и заканчивая возможностью поддержки по электронной почте либо по телефону 

специалистами NI. 

Declaration of Conformity (Декларация о соответствии) — Декларация о соответствии – это 

наше заявление о соответствии требованиям Совета Европейских сообществ к 

производителям. Эта система обеспечивает защиту пользователя от проблем 

электромагнитной совместимости (EMC) и безопасности продукта. Вы можете получить 

декларацию о соответствии вашего продукта на сайте ni.com/certification. Если ваш 

продукт поддерживает калибровку, вы можете приобрести для него калибровочный 

сертификат на сайте ni.com/calibration. 

Штаб-квартира корпорации National Instruments располагается по адресу 11500 North Mopac 

Expressway, Austin, Texas, 78759-3504. Также National Instruments имеет офисы по всему 

миру для обеспечения технической поддержки. Для получения поддержки по телефону в 

США создайте запрос на странице ni.com/support и следуйте инструкциям, либо 

позвоните по номеру 512 795 8248. Для получения поддержки по телефону вне 

Соединенных Штатов вы можете также посетить раздел Worldwide Offices на сайте 

ni.com/niglobal для доступа к веб-сайтам филиалов, где имеется обновляемая 

контактная информация, телефоны службы поддержки, адреса электронной почты и 

информация о текущих событиях. 

 

 

 

 

 

 

 

 

 

 

 

 

LabVIEW, National Instruments, NI, ni.com, логотип корпорации National Instruments и логотип с орлом являются торговыми 
марками корпорации National Instruments. За более подробной информацией о торговых марках корпорации National Instruments 
обратитесь к разделу Trademark Information на сайте ni.com/trademarks. Названия других упомянутых в данном руководстве 

изделий и производителей также являются торговыми марками или торговыми именами соответствующих компаний. Для 
получения информации о патентах, которыми защищены продукция или технологии National Instruments, выполните команду 
Help»Patents из главного меню вашего программного обеспечения, откройте файл patents.txt на имеющемся у вас компакт-

диске или зайдите на сайт ni.com/patents. Вы можете найти лицензионные соглашения с конечным пользователем (EULAs) и 

правовые положения сторонних производителей в документе NI 5782 Readme. Обратитесь к документу Export Compliance 
Information на странице ni.com/ legal/export-compliance за глобальными принципами торговой политики NI, а также, 

чтобы получить необходимые коды HTS, ECCNs и прочие данные об экспорте/импорте. 
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